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Chapitre 4  Symbolisation  
 

1-1. Configuration des préférences dans Illustrator 
Avant de commencer, configurer les unités dans la fenêtre des « préférences » 
 
1. Dans Edit (édition)/ sélectionner Preferences (préférences)/Units (unités) 
2. Définir les unités dans chaque menu déroulant comme suit, puis cliquer sur OK. General: 

Millimeters, Stroke (trait): Millimeters, Type: Points. 
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1-2. Importation de fichier DAO (dessin assisté par ordinateur, en anglais CAD 

file) 
 
1. Importer un fichier DXF/DWG 
 
① Dans File (Fichier), sélectionner Open (ouvrir). 
② Sélectionner le fichier DWG cible (fichier de travail) dans votre répertoire et cliquer sur OK. 
③ Quand l'on ouvre un fichier DWG qui a été mis à l'échelle pour la symbolisation, cocher la case 

« Original Size » (taille originale). L'échelle (Scale) devrait être à 1, Unité(s) (Unit(s)) à 1 
Millimeters (millimètres). Cliquer ensuite sur OK. 

 
 
④ Si le fichier DWG n'a pas encore été mis à l'échelle, cocher la case « Original Size » (taille 

originale). L'échelle (Scale) devrait être à 1, Unité(s) (Unit(s)) à 0,02 Millimeters 
(correspondant à une échelle au 1/50.000ème). Cliquer ensuite sur OK. 
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Ou bien cocher la case « Scale by » (mettre à l'échelle de ... ) et saisir la valeur de 2% (valeur 
correspondant à l'échelle d'1/50.000ème). 
La fenêtre d'échelle affichera alors les valeurs de 1 pour l'échelle (Scale) et de 1 millimètre pour 
les unités (Unit(s)). Cliquer sur OK. 
 

 
 
2. Dégrouper les objets 
 
① Tout sélectionner (Ctrl + A) 

 
 

② Dans « Object », sélectionner « Ungroup » (dégrouper). Il peut être nécessaire de répéter la 
manœuvre plusieurs fois jusqu'à ce que le groupe soit entièrement dégroupé.  
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3. Copier tous les objets 
 
① Afficher les règles dans « View » (affichage), sélectionner « Rulers » (règles)/« Show Rulers » 

(afficher les règles)  
Quand la règle globale est active, on permutera vers les règles du plan de travail (« Artboard »).  
Dans « View » (affichage), sélectionner « Rulers » (règles) / « Change to Artboard Rulers » 
(Passer aux règles du plan de travail).  

 
② Activer uniquement la couche de l'orle.  

Bouton en haut à droite du panneau de couches (« layers panel ») > Dérouler > Sélectionner     
« Hide Others » (cacher les autres) ou Cliquer (Alt + clic) sur l'icône en forme d'œil à côté de la 
couche que l'on veut isoler. 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 Alt+clic pour désactiver les 

autres couches   
 La couche sélectionnée sera 

affiché.   
 
 
 

 
③ Sélectionner l'orle.  

Tout sélectionner (Ctrl + A) ou cliquer sur la couche de l'orle dans « Layers » (couches) 
 

 
 

Alt + clic 
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Si le point central de l'orle n'est pas affiché, on peut le faire en recourant au panneau Attributs     
(« attribute panel »).  

Cliquer sur le bouton « Show 
center » (afficher le centre). 

 
 
 

④ Afficher le repère commenté Ctrl + U). Puis faire coïncider le centre des règles avec celui de 
l’orle. 
 
 

Faire glisser le point d'origine des 
règles vers le centre de l'orle.   
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⑤ Bouton en haut à droite du panneau de couches (« layers panel) > Dérouler > Sélectionner     
« Show All Layers » (afficher toutes les couches) ou Cliquer (Alt + clic) sur l'icône en forme 
d'œil à côté de la couche. Toutes les couches seront affichées d'un coup. 
Ensuite, sélectionner tout (Ctrl + A) et copier (Ctrl + C). 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 Alt + clic, afficher toutes 

les couches d'un coup.  
 
 
 
 
 

 
 
 
4. Coller dans le ficher LEGEND 
 
① Ouvrir le ficher LEGEND (Ce fichier LEGEND, dont l’ordre des couches est défini pour toutes 

les couches, doit être élaboré avant le travail de symbolisation).  
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② Dans le menu déroulant des couches (« Layers »), cocher « Paste Remembers Layers » (coller 
selon les couches).  

 
 
③ Coller devant (Ctrl + F). 
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5. Enregistrer sous (« Save as ») 
 
① Dans « File » (fichier), sélectionner « Save as » (enregistrer sous) 
② Saisir un nom de fichier et cliquer sur « Save » (enregistrer) 
③ Décocher les cases de la fenêtre de dialogue des options d'Illustrator (« Illustrator options »), 

puis OK. 
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1-3. Symbolisation de base 
 
• Symbole linéaire 1 (objets linéaires, « DATA TYPE » (type de données) : « Line » (ligne), ex. 

ligne simple de route, ruisseau, courbe de niveau et autres symboles de représentation de lignes 
simples etc.) 

 
1. Verrouiller toutes les couches excepté la couche cible. « Layer panel » (Panneau des 

couches)> ▼ > « Lock Others » (verrouiller les autres), ou Alt + clic sur l'icône en forme 
d'œil.  
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 Alt + clic permet de 

verrouiller toutes les 
couches excepté la 
couche cible 

 
 
 
 
 
 
 
 
 
 
2. Coins arrondis   

Le tracé (symbole linéaire) est transformé en ligne courbe afin d'avoir une apparence plus lisse.  
Sélectionner tous les tracés dans la couche cible. Ctrl + A ou Alt + clic sur la couche cible dans 
le panneau des couches. 
 

Alt + clic 
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Effect / Stylize /Round Corners (coins arrondis) 
Saisir la valeur du « Radius » (rayon), puis cliquer sur OK. (La valeur du rayon est spécifiée en 
fonction de l'état de la ligne. Les objets symbolique concernées sont les contours, les cours 
d'eau, les routes et autres objets requérant une apparence lisse). 
 

 
 

 
 
 
3. Après avoir arrondi les coins, on procédera à la « décomposition de l'aspect »   

Object/ Expand Appearance (Décomposer l'aspect) 
 

 
 
 
4. Le tracé sera simplifié si nécessaire. 

On réduira ainsi les points d'ancrage dans le tracé. Cela peut permettre de réduire le volume de 
données.  
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« Select Path » (Sélectionner un tracé)/ « Simplify » (simplifier) 
 
On paramétrera la précision de la courbe (« Curve Precision ») à exactement 100 % puis on 
cliquera sur OK. 

Cela permet de réduire le nombre de 
points.  

 
 
Le nombre de points d'ancrage du tracé sera réduit tout en conservant quasiment la forme 
précédente du tracé. 

 
 
 
5. Copier un symbole cartographique cible à partir du fichier de « Spécifications de 

symbolisation ». Puis le coller dans le fichier en cours dans une « couche temporaire ». 
 
① Copier le symbole cartographique cible. 

0,4 mm    0,3 mm     0,2 mm 

 
 

Épaisseur de la ligne : 0,4 mm – 0,2 mm 
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② Revenir dans le fichier de travail en cours, et créer une nouvelle couche tel qu’une couche 
temporaire pour ce symbole.  
« Layers panel » (Panneau des couches) / ▼ / « New Layer » (nouvelle couche), ou cliquer sur 
le bouton « Create New Layer » (créer une nouvelle couche). 

 
 
③ Verrouiller toutes les couches sauf cette « couche temporaire ».  

Décocher « Paste Remembers Layers » (coller selon les couches).   
Puis coller le symbole (Ctrl + V) 

Cliquer et 
verrouiller. 
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6. Les attributs de couleur, de largeur de ligne, d'intervalles des lignes pointillées peuvent 

être transférés à l'aide de « Eye dropper tool » (l'outil pipette).  
 
① Verrouiller toutes les couches sauf la couche concernée.   

Sélectionner tous les tracés dans la couche concernée (Ctrl + A) ou Alt + clic sur la couche 
concernée dans le panneau des couches.  

 
 

Déverrouiller.  
 
② Sélectionner la ligne à symboliser, puis transférer les attributs à partir des « Spécifications de 

symbolisation » à l'aide de l'outil pipette  
La ligne plane sera transformée pour devenir similaire au symbole copié. 
 

 
 
 
 

③ Après cette modification, on supprimera la couche temporaire. 
« Layers panel » (Panneau des couches)/ ▼ / « Delete » (supprimer), ou cliquer sur le bouton 
« Delete Selection » (supprimer la sélection). 
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• Symbole linéaire 2 (« DATA TYPE » (type de données) : « Line » (ligne), ex. : route à double 
ligne)  
Le tracé (symbole de ligne) est transformé en courbe afin d'avoir une apparence plus lisse.  
Le tracé (symbole de ligne) est simplifié en courbe afin de réduire les points d'ancrage ce qui 
permet de diminuer le volume de données.   

 
 
1. Copier un symbole cartographique cible à partir du fichier de « Spécifications de 

symbolisation ». Puis le coller dans la « couche temporaire ». 
 
① Copier le symbole cible. 

0,9 mm0,4 mm 

 
② Revenir dans le fichier de travail en cours, et créer une nouvelle couche tel qu'une « couche 

temporaire » pour ce symbole.  
 

 
③ Verrouiller toutes les couches sauf cette « couche temporaire ».  

Décocher « Paste Remembers Layers » (coller selon les couches).   
Puis coller le symbole (Ctrl + V) 
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2. En premier lieu, appliquer un attribut aux objets de la couche « 2002 » à l'aide de l'outil 

pipette. Puis, appliquer un attribut aux objets de la couche « 2002_f » de la même façon.  
 
① Sélectionner la ligne à symboliser « couche 2002 », puis transférer les attributs du symbole 

copié dans la couche temporaire à l'aide de l'outil pipette.  
La ligne plane peut se transformer et devenir similaire au symbole copié. 
 

 

2002 2002_f 
  

 
 
 

   
② Sélectionner tous les tracés dans la couche. Puis copier 
 
 
③ Verrouiller toutes les couches sauf la couche « 2002_f ».  

Décocher « Paste Remembers Layers » (coller selon les couches).  
Puis coller devant (Ctrl + F) dans la couche « 2002_f » 
 

 
 

 
④ Sélectionner la ligne à symboliser, puis transférer les attributs du symbole copié, à l'aide de 

l'outil pipette  
La ligne plane peut devenir similaire au symbole copié. 
 

        

  2002_f 2002 
 
 
 
 

  
 
⑤  Après cela, on supprimera la « couche temporaire ». 
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• Symbole de point (« DATA TYPE » (type de données : Point, ex.: École) 
 
1. Importer le fichier de pinceau (« Brush ») enregistré en tant que bibliothèque de pinceau à 

partir du panneau des pinceaux (« Brushes » panel)  
Ce fichier de ressources matérielles telles que les « pinceaux » (brushes) doit être élaboré 
avant le travail de symbolisation. 

 
① Ouvrir la bibliothèque de pinceaux. 

« Brushes panel » (Panneau des pinceaux) > « Open Brush Library » (ouvrir la bibliothèque de 
pinceaux) > « Other Library » (autre bibliothèque) 

 
 
② Sélectionner le fichier de pinceau (« Brush ») voulu dans votre répertoire, puis cliquer sur     

« Open » (ouvrir).  
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2. Appliquer le pinceau (« Brush ») aux points. 
 
① Sélectionner tous les tracés dans la couche cible. 

 
 
② Cliquer sur le pinceau (« brush ») concerné dans le panneau des pinceaux (« Brushes »à. 

 
Par exemple, cliquer sur le symbole d'école 3115.  
 Clic 
 
3. Après application des pinceaux, s'assurer qu'ils sont en mode d'aspect décomposé        

(« Expand appearance »).  
① Sélectionner tous les objets de pinceau dans la couche concernée.  

 
 

 
② Dans « Object », sélectionner « Expand Appearance » (Décomposer l'aspect) 

Quand les formes sont appliquées, ces symboles sont considérés comme des points. Il faut 
procéder à la « décomposition de leur aspect » pour les transformer en objets normaux qui 
peuvent être tournés, déplacés, et mis à l'échelle.  
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• Symbole de polygone 1 (« DATA TYPE » (type de données) : Polygone, ex. : Cimetière) 
 
1. Copier un symbole cartographique cible à partir du fichier de « Spécifications de 

symbolisation ». Le coller ensuite dans la couche ayant le même nom dans le fichier du 
travail en cours. 

 
① Copier un symbole cartographique cible à partir du fichier de « Spécifications de 

symbolisation ». 

1,5 mm
2,4 mm

 
 
 
② Revenir au fichier de travail en cours, et cocher « Paste Remembers Layers » (coller selon les 

couches).  

 
③ Coller le symbole (Ctrl + V). Le symbole sera collé dans la même couche grâce à la fonction 

« coller selon les couches ». 

  
 
 
 3107_f 

0,8 mm 3,2 mm

Épaisseur de la ligne 0,1 mm
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2. Ajuster les symboles cartographiques. 
 
① Ajuster la position, le nombre des symboles cartographiques avec « Selection tool » (outil de 

sélection).  

      
 
② Sélectionner les symboles cartographiques inutiles et les supprimer.  

 
 
③ La couleur de contour de polygone n'est pas nécessaire. 

Pour amener la couleur de contour au premier plan, cliquer sur le bouton de « stroke color » 
(couleur de contour) dans « Color panel » (panneau des couleurs).  
Elle viendra au premier plan. Ensuite, cliquer sur la case « None box » (pas de couleur de 
contour).  
 Cliquer sur le bouton « stroke » (contour) pour activer le contour. 

 
 
 Cliquer sur le bouton « None » (pas de couleur) de la couleur de contour. 
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• Symbole de polygone 2 (« DATA TYPE » (type de données) : Polygone, ex. : forêt, savane) 
 
1. Importer les « Spécifications de symbolisation » par le nuancier (« Swatches » panel).  

Ce fichier de ressources matérielles telles que les « nuances » (swatches) doit être élaboré avant 
le travail de symbolisation. 

 
① Ouvrir la bibliothèque de « swatch » (nuances). 

« Swatches panel » (Nuancier)/ « Open Swatch Library » (ouvrir une bibliothèque de nuances)/ 
« Other Library » (autre bibliothèque) 

 

 
 

② Sélectionner le fichier voulu et cliquer sur « Open » (ouvrir) 
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2. Appliquer une couleur de remplissage aux objets à l'aide du panneau des couleurs, du 

nuancier.  
 
① Sélectionner tous les objets dans la couche concernée.  

 

 
 
② Paramétrer les couleurs de contour (« stroke color ») sur « none » (pas de contour) et activer la 

couleur de remplissage.  

 
 

Forêt 

Savane 
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③ Choisir la couleur voulue dans le panneau de nuancier (« Swatches »). 

 
 
 
 
 

 
 

Clic 

 

 
④ Saisir la valeur de couleur en %. 
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⑤ Pour le remplissage de la zone de savane, choisir le motif voulu dans « Swatches panel » 

(panneau de nuancier). 

   
 
 Clic 
 
 
3. Créer un tracé transparent 

 

 
 

Forêt 

Savane 

Le polygone a été évidé à 
l'intérieur comme un anneau.
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① Sélectionner le polygone extérieur et le polygone intérieur qu'il entoure en gardant appuyée la 

touche shift (MAJ) ou Ctrl.  

 
② « Object » / « Compound Path » (tracé transparent) / Make (créer) 
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③ Si le polygone intérieur ne peut pas creuser le polygone extérieur, on changera la direction du 
tracé à l'aide du panneau Attributs. 

 
 
Sélectionner le polygone intérieur qui pose problème avec « Direct selection tool » (outil de 
sélection directe), puis choisir l'un ou l'autre des boutons « ON or OFF » dans « Reverse Path 
Direction » (inversion de la direction du tracé).    

 

Cliquer sur l'un ou l'autre de ces boutons. 
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1-4. Autres symbolisations es symbolisations 
  
1-4-1 Ajuster un pont sur une route 1-4-1 Ajuster un pont sur une route 
  
Un pont est de plus de 50 m de longueur, en briques, en métal  Un pont est de plus de 50 m de longueur, en briques, en métal  
  

Taille d'échelle 

Pont; taille d'échelle (« DATA TYPE » (type de données : « Line » 
(ligne)) 

0,5 mm 

 
 
 
 

 -: Cocher 
 
 
 
 
 
 
 

② Aligner avec la route à l'aide de l'outil de 

 
 
 
 

③ Ajuster la longueur à l'aide de « Direct select 
 » (o

 
 
 

④ Après que le symbole est ajusté et mis en place, 
gne

  longueur inférieure à 50 m.

Pont ; taille d'échelle 

① *Coller le symbole dans la même couche à partir de 
la palette de symboles en mode « Paste remembers 
layer » (coller selon les couches). 

« Paste Remembers Layers » (coller selon les couches). 

rotation. 

tool util de sélection directe). 

la li  originale qui provenait des données de DAO 
sera supprimée.  
 Le pont est d'une 
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Taille minimale  

2,0 mm 

 Pont; Symbole de point régulier (« DATA TYPE » (type de 
données : Point) 

 
 

otation. 
 

 
 
 

① Coller le symbole dans la même couche à partir 
de la palette de symboles en mode « Paste remembers layer 
» (coller selon les couches). 

-: Les symboles seront décomposés. 
-: Cocher « Paste Remembers Layers » (coller selon les     

couches). 
 
 
 
 
 
 
 
 
 

② Aligner avec la route à l'aide de l'outil de r
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1-4-2 Aligner les annotations le long des éléments linéaires telles que noms de cours d'eau, 
noms de montagnes, de routes, etc. 
 

 
 
① Couper (Ctrl + X) ou copier (Ctrl + C) un texte.  

 
 
② Dessiner avec l'outil stylo un tracé pour ajuster l'annotation le long de l'élément linéaire. 

 
 
③ Cliquer sur le tracé avec l'outil de saisie de texte sur un tracé (« Type on a Path Tool ») 

Cliquer sur le tracé

 
 
④ Une fois collé (Ctrl + V), le texte original, dans le cas où il avait été copié, sera supprimé.  

 

Après l'avoir collé en position 
appropriée, supprimer le texte 
original. 
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caractères soient tous affichés. 

⑤ Si les caractères du texte ne rentrent pas dans l'espace situé le long du tracé, dessiner le tracé 
avec l'outil stylo, ou faire glisser le « crochet » à l'extrémité du tracé de telle manière que les 

 
 
Ce signe indique que tous les caractères ne sont 
pas affichés. 
 
 
 
 
 
Ajouter un tracé supplémentaire avec l'outil stylo. 
 
 
 
 
 
 
 
 
Si le pointeur est amené à proximité du crochet, 

une petite icône «  » apparaît. Faire alors 
glisser le crochet.  
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1-4-3 Créer avec la commande Décalage (« Offset Path ») 

 
Pente abrupte 

Pente abrupte; (« DATA TYPE » (type de données) : 
« Line » (ligne) 
 

 
 

  Ligne supérieure : provenant des données 
                  DAO 

La ligne hachurée est un objet décalé.   
 
 
Objet décalé : créer une ligne hachurée (nip line) 

① Sélectionner les objets. 
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② « Choose Object » (Choisir 
objet) > « Path » (tracé) >  
« Offset Path » (tracé 
décalé). 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
 
 
 
 

③ Saisir la longueur de la moitié de la 
ligne hachurée dans la zone de texte 
du décalage (« Offset »). Cliquer 
ensuite sur « OK ».  

 
* Après le décalage des tracés, pour que le 
travail suivant soit plus efficace, il sera 
bon de les stocker dans un certain nombre 
de « couches de travail provisoires » 
 
 

 
 

④ Sélectionner les objets. 
Le côté de tracé superflu doit être 
supprimé à l'aide de l'outil Ciseaux.  
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 Couper

Appliquer un attribut avec l'outil pipette. 
attribut de ligne sera transféré à votre 
jet linéaire. 

 
 
 
 

 
 Ou encore saisir dans « STROKE » (contour) la 

e r
ed li

 les tracés aux deux extrémités ⑤
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
 
 

⑥ 

     
 
 

L'
ob

valeur d
et « Dash

 

s att ibuts de ligne : « Weight » (épaisseur) 
ne » (ligne discontinue) 
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éments linéaires sont à supprimer.  
 
Lim

e limites recouvrent celles d'un élément de route, 
 supprimer.  

(2) Les lignes recouvrant l'orle de la carte sont à supprimer 
 

 
 
 
Cette ligne d'eau recouvrant l'orle doit être 
supprimée. 
 
Ces lignes qui recouvrent l'orle nuiraient à l'aspect 
de la carte finale lorsqu'elle est imprimée en offset. 
 
 
 
 
 
 
 
 

1-4-4 Autres symbolisations 
 

(1) Les lignes recouvrant d'autres él

ites d'une certaine zone de lotissement 
 
 
 
Si des lignes
elles sont à
 
 
 
 
 

Zone 

 d

 
 
 
 
 
 
 
 
 
 
 
 
 

Zone 

 
 

Ligne d'eau Eau 

Orle 

Orle 
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(3 chevée jusqu'à l'orle. 

Il

 
) Étendre une ligne ina

 
 y a un espace entre l'orle et le symbole de route.  

 
 
 

 
 
Recourir à l'outil Stylo racer la
 
O  sélectionner u queme
sélec on directe, puis rer le poi
la bonne direction.    
 
 

 

. T  ligne jusqu'à l'extérieur de l'orle 

nt les points à l'extrémité des objets à l'aide de l'outil de 
nt d'ancrage sélectionné au delà de l'orle, en gardant 

 
 

u bien
ti

ni
ti
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les données de restitution stéréo, 

l'apparence des symboles est celle de simples 
éléments géométriques : des points, des lignes et 
des polygones.  

 
 
 
 
 
 
 
 
 
 
 
 
② Cependant, quand ces éléments géométriques 

sont converties en symboles appropriés, certains 
symboles vont se chevaucher.  

 

 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
 
③ Les symboles qui se chevauchent doivent être 

déplacés en prenant en compte les relations 
entre l'échelle de la carte et ses éléments 

 
Quand les symboles recouvrent les routes, les parties 
recouvertes sont à masquer afin de rendre les 
symboles plus clairs. 
 
 
 
 
 

 
(4) Déplacement de symbole se recouvrant 

① Dans 
Données de restitution stéréo 

Données d olisation : avant 
déplacem

e symb
nt e

 

 
 

Chevauchement 

Données de symbolisation : après 
déplacement 
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n matière de déplacement de symboles, il faut prendre en compte le « jugement du cartographe » 
pour s' de l'objet représenté.  
 

0

poin
u mi  les uns des autres. 

  symbole cartographique ont la même couleur, ils 
m des autres. 

ins 1,0 mm et d’au plus 2,4 mm. 

ou des annotations recouvrent une ligne de même 
 t endroit par le « masque correcteur » (« hold out 

E
éloigner le moins possible de la position réelle 

De façon générale, pour des cartes au 1/50.0
au maxim e.  
* On p boles de 
* Les symboles de point doivent être espacés a
* Quand une annotation ou un élément ou

doivent être espacés au minimum de 0,2 m
* La position horizontale sera déplacée d’au m
 
 

(5) Quand des symboles de polygones 
couleur, la ligne sera masquée à
mask »)  

 

0ème, la distance de déplacement accumulée doit être 

ts de 20 %. 
nimum de 0,2 mm

um de 2,4 à 2,6 mm sur la cart
ourra réduire l'échelle des sym

un
 les uns 
o

ce
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vrement des symboles, 
il faut prendre en considération l'ordre de priorité des symboles et l'ordre entre les 

tres symboles. 

 
 

 
 
Route « ***f » 
 
 
Masque correcteur  
 
 
Routes 
 
 
Site (couleur du sol) 
 
 
 
Derrière : Il doit s'agir d'éléments quasiment 
pleins, des éléments polygonales provenant des 
données DAO.  
 
 
 
 
 
 
 
 
 
 
Le masque correcteur sera créé en recourant aux 
couleurs et motifs de l’arrière-plan. 
 
 
 
 
 
 
 
 

 
(6) Quand on recourt au masque correcteur pour éviter le recou

couches. 
 
 

Devant : priorité haute 
Les annotations doivent être prioritaires par 
rapport aux au
 

 
Symboles 
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a pour cela à l'outil Pipette ou au panneau de couleurs. 

 
(7) Configurer la couleur de remplissage du masque correcteur qui doit être la même 

que la couleur de fond. 
On recourr
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1-5. 
 
① Par exe  le feuillet côté gauche 

(Ctrl + 0), 
Sélectionner le feuillet contigu de droite avec l'outil de sélection directe en sélection glissante de 
haut à droite vers le bas à gauche, puis copier (Ctrl + C).   

 
Joindre des feuillets contigus 

mple, pour joindre deux feuillets adjacents gauche et droite, ouvrir

 
 
② Ouvrir le feuillet de droite et créer une nouvelle couche pour coller le feuillet adjacent, décocher 

l'option « Paste Remembers Layers » (coller selon les couches), puis activer cette couche.  
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lle nouvelle couche ainsi créé (Ctrl+V).   

 
③ Co r le fichier du feuillet de droite dans la 

 
 

Mettre l’outil de sélection      (selection tool) au coin du côté droit, puis le bouger et 
l’accrocher à la partie gauche de la carte en cours, au coin gauche.  

 

④ Activer le repère commenté (Smart guide) à partir du menu déroulant View (affichage) ou 
avec Ctrl + U 

 
Déplacer en glissant vers le coin, quand l'accrochage se fait, la flèche devient blanche.  
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anche.  

Quand on effectue un déplacement et un accrochage à un autre coin de feuillet, on zoomera à 
chaque coin afin de vérifier la coïncidence.  

⑤ Déplacer en glissant vers le coin, quand l'accrochage se fait, la flèche devient bl

 

Feuillet gauche  Feuillet droit

 
 

⑥ Activer toutes les couches, vérifier les feuillets joints. 
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⑦ Modifier l'affichage en passant en mode Tracés (« Outline view ») (Ctrl + Y) ou en zoomant, 
selon les nécessités.  

 
 
 

⑧  à cet usage sera supprimé.  Une fois le travail de jonction terminé, la nouvelle couche créé 

 
 
Choisir  « Layers panel menu » (menu du panneau des couches) > ▼ > « Delete » “Layer ***” 
(Supprimer la « couche *** ») ou cliquer sur « Delete Selection » (supprimer la sélection). 
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1-6. Créer le masque correcteur 
 
 L'ex masqué avec un objet masque appelé « masque de feuillet » ou 

« masque correcteur de l'orle » etc. 
 
① Copier l'orle (Ctrl + C). 
Décocher « Paste Remembers Layers » (coller selon les couches) dans le menu du panneau des 
couches («Layer Panel) ». 

 

térieur de l'orle doit être 

    
 
② Sélectionner l'orle et le copier (Ctrl + C)  
③ Coller devant (Ctrl + F). 
④ Glisser le petit bouton en surbrillance à droite vers l’intérieur de la couche du masque de 

feuillet. Cela permet de déplacer l'objet collé vers la couche concernée.  

 
 

 
 
⑤ Changer l'échelle de l'orle ainsi dupliqué à un certain pourcentage tel que 105 ou 110 %. 

Alt + clic : 
Verrouille d'un coup tous les calques 
excepté la couche concernée. 
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Cela permet de lui donner la taille appropriée.  
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⑥ Créer un tracé transparent, et le remplir de la couleur CMYK = 0 panneau de couleurs.  dans le 

 
Créer un tracé transparent. Sélectionner les objets et choisir « Object » > « Compound Path » (tracé 
transparent) > « Make » (créer). 

 
 

 
 
Panneau de couleurs 
Remplissage : CMYK = 0 contour : Aucun. 
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① Ouvrir « 013_04_08_LEGEND_TOGO.ai » (Ctrl + O) puis le sélectionner et le copier 

(Ctrl+C). 
Un fichier de légende ayant des couches, et la dimension des éléments marginaux doivent être 
préparés avant de démarrer le travail de symbolisation.  

 
1-7. Légende et renseignements marginaux 

 
 
② Dans le fichier de travail en cours, coc

couches) dans le panneau des couches. 
 

her « Paste Remembers Layers » (coller selon les 
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ne fois collés les objets de légende seront si nécessaire ajustés à la position appropriée. 

 
③ Coller devant (Ctrl + F) 

U
 

 
Mode Tracés (« Outline view ») 

 

 
Mode Aperçu 
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. cations à effectuer avant l'impression offset 

① Afficher toutes les couches et les déverrouiller tous.  
    Choisir dans le menu du panneau des couches :  
 

 
1-8  Résumé des vérifi

 

 
 

LAYER panel (panneau des couches) > ▼ > Show all layers (afficher toutes les couches) 
 

LAYER panel (panneau des couches) > ▼ > Unlock all layers (déverrouiller toutes les couches) 
 
② Tous déverrouiller et afficher tous les objets. 

Sélectionner tous les objets (Ctrl+A) et choisir dans le menu déroulant « Object ». 
 

 
 

« LAYER panel » (panneau des couches) > ▼ > « Show all layers » (afficher toutes les 
couches) 

 
« LAYER panel » (panneau des couches) > ▼ > « Unlock all layers » (déverrouiller toutes 

les couches) 
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On  décomposera l'aspect » des objets de pinceau (« brush ») qui sont présents en tant que 
don

t  > « Expand Appearance » 

 
 
 
 
 
 
 
 
 
Il n'est pas nécessaire de décomposer si l'option « décomposer 
l'aspect » est désactivée. 
 
 
 
 
 
 
 

 
④ Dégrouper  

Les groupes superflus seront défaits. 
Sélectionner les obje

 
③ Décomposer l'aspect 

 «
nées de points.  

jec  »Sélectionner tous les objets (Ctrl + A) et choisir « Ob
(décomposer l'aspect). 

ts et choisir « Object » > « ngroup » (dégrouper).  U
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texte vides 
 

⑤ Supprimer les tracés de 
 

 
1. Choisir « Object » (o jet) > « Path » (tracé) > « Clean Up » (nettoyer). 

 
b

 
 

2. Sélectionner les tracés de textes vides et cliquer sur OK. 
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⑥ Supprimer les points errants 
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⑥ Supprimer les points errants 
 

 

Points errants 

1. Trouver les points d'ancrage errants.  
Choisir « Select » (Sélectionner) > « Object » > « Stray Points » (points errants). 

 

 
 

2. Supprimer les points d'
*Les objets de pincea  de procéder à la suppression 
des points errants.  
* Il se peut que soient sélectionnés des points isolés qui ne sont pas des points errants, 
et l'on vérifiera donc quels sont les points à supprimer avant de procéder à la 
suppression.  
 
 

ancrage errants. 
u doivent être décomposés avant



 

 
 

4-52

Étude sur l'établissement d’une base de données topographique au Togo
Manuel de transfert de technologie 

ent  

1. Vérifier si vous n'avez pas recouru à des polices qui ne sont pas spécifiées dans le 
document.   Choisir « Type » > « Find Font » (rechercher une police) 
 

 
⑦ Vérifier tous les textes dans le docum

 

 
 

2. Sélectionner le nom d'une police dans la liste puis cliquer sur Find (rechercher) pour 
rechercher automatiquement la police sélectionnée dans le fichier en cours.  
 
Sélectionner une police de remplacement dans la liste qui s'affiche lorsque vous 
choisissez « Document » dans le menu déroulant « Replace With Font From » 
(Remplacer par une police provenant de :), auquel cas seules les polices présentes dans 
le document seront affichés, ou dans la liste qui s'affiche lorsque vous choisissez 
« System », auquel cas toutes les polices présentes dans votre ordinateur seront 
affichées. Cliquer sur « Change All » (tout modifier). Cliquer sur « Done » (terminé) 
pour fermer la boîte de dialogue. 
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⑧ onfiguration de la surimpression 

 
1. Pour surimprimer tous les objets noirs dans votre travail («  à 

l'option Surimpression du noir (« Overprint Black ».). Séle ts 
(Ctrl + A) et choisir « Edit » (édition) > « Edit Colors » (modifier les couleurs) >    
« Overprint Black » (surimpression du noir). 

 

C

 artwork »), recourir
ctionner tous les obje

 
 

2. Choisir « Add Black » (ajouter le noir) dans le menu déroulant.  
Saisir « 100 » dans la zone de texte de pourcentage.  
Sélectionner « Fill » (remplissage) et « Stroke » (contours) pour spécifier comment 
s'appliquer la surimpression.    
Cliquer sur OK. 
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ns directs à 100 % dans le panneau des attributs.  
La configuration des couleurs doit être en conformité avec les spécifications des 

 
3. La surimpression s'appliquera aux to

symboles. 
 

 
 

4. La surimpression ne doit pas être appliquée aux objets blancs (CMYK 0%) ni aux 
couleurs de remplissage de moins de 100% Décocher l' ption surimpression du 
remplissage et du contour.  

o
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A t
d'un c

    
Choisir  « Clear Guides » (supprimer les 

uides). 

 
⑨ Supprimer les repères  

 
van  impression, il faut supprimer les repères superflus. Ils peuvent être tous supprimés 

oup : 

 « View » (affichage) > « Guides » (repères) >
g

 
 
Si les repères s
Puis sélectionn  repères), et tous les repères seront supprimés d'un 
coup. 

 

ont verrouillés, les déverrouiller.  
s » (supprimer leser « Clear Guide



 

 

 

 

 

Structuration des données 
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Chapitre 5-1-1  Maniement de base d'ArcGIS  
 

1-1 Processus du travail  

Ouvrir ArcMAP 10 

Ajouter des données) 

Configuration des symboles

Configuration des étiquettes

Configuration des images raster

Enregistrer la configuration. 

 

 

 

1-2 Ouvrir ArcMAP 
(1) Ouvrir un nouveau fichier « ArcMAP 10 ». 

Cliquer sur l'icône du raccourci d'ArcMAP 10 sur le bureau. 

(2) La fenêtre suivante apparaît.   

 

  
 

 5-1-1-1 



Étude sur l'établissement d’une base de données topographique au Togo 
Manuel de transfert de technologie  

1-3 Add Data (Ajout de données)  
(1) Ajout de données  

 

(2) Sélectionner le fichier.   

 
(3) Les données sélectionnées sont affichées dans la fenêtre. 

    

 5-1-1-2 
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1-4 Configuration des symboles  
(1) Sélectionner la couche à configurer et ouvrir la fenêtre des propriétés (« properties »).  

  

 

(2) Aller dans l'onglet « Symbology » et cliquer sur le bouton de configuration (« setting ») 

 

(3) Configurer la couleur, la largeur (« width »), etc. et cliquer sur OK.  

 

 5-1-1-3 
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(4) Après cela, retourner à l'onglet « Symbology », et cliquer sur OK dans cet onglet. 

 

1-5 Configuration des étiquettes  
(1) Sélectionner la couche à configurer et ouvrir la fenêtre des propriétés (« properties »).  

(2) Aller dans l'onglet des étiquettes (« labels ») et cocher « Label features in this layer » (étiqueter les 

entités dans cette couche). 

  

 
(3) Sélectionner le champ d'étiquette (« Label Field ») qui est à afficher, et configurer les symboles de 

texte (couleur, taille, etc.).  

(4) Si nécessaire, activer le contrôle de duplication en cliquant sur « Placement Properties » (propriétés de 

placement). 

 

 5-1-1-4 
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1-6 Configuration des images raster  
(1) Ajout d'une image raster 

Sélectionner le fichier de l'image et cliquer sur « Add » (ajouter) 

 
(2) S'il n'y a pas de fichier pyramide, la fenêtre suivante apparaît : 

Cliquer sur « Yes » (oui) pour créer un fichier pyramide. 

 

(3) Sélectionner l'image ajoutée et ouvrir la fenêtre des propriétés  

 

 5-1-1-5 
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 5-1-1-6 

(4) Aller dans l'onglet « General » et cocher « Don’t show layer when zoomed » (ne pas afficher la couche si 

elle est zoomée...) et configurer « Out beyond scale » (l'échelle de zoom arrière au delà de laquelle la 

couche ne sera pas affichée.   

 

1-7 Enregistrer la configuration.  
   Choisir un dossier approprié et enregistrer sous un nom approprié au format *.mxd. 
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Chapitre 5-1-2  Maniement de base d'ArcCatalog 
 

2-1 Ouvrir ArcCatalog 
(1) Ouvrir « ArcCatalog » à partir du menu démarrage. 

 
(2) La fenêtre suivante apparaît.   

 

 5-1-2-1 
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2-2 Copier, renommer, supprimer un fichier de forme (fichier shape)   
Sélectionner le fichier et faire un clic droit pour le copier (« Copy »), le renommer (« Rename ») ou le supprimer  

(« Delete »). 

 

2-3 Créer un nouveau fichier de formes  
(1) Sélectionner le dossier dans lequel le nouveau fichier de formes sera créé dans l'arbre catalogue (« Catalog 

tree »)   

 

 5-1-2-2 
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(2) Faire un clic droit et sélectionner « New » (nouveau) --> « Shape file » (fichier de formes) à l'intérieur de 

l'onglet « Contents » (contenu).  

 
(3) Saisir un nom, choisir le type d'objets (« Feature type »), puis cliquer sur le bouton « Edit » (« édition ») 

 

 5-1-2-3 
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(4) Cliquer sur le bouton « Select » (sélectionner)   

 

(5) Sélectionner le système de coordonnées   

 

 5-1-2-4 
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2-4 Configuration de la projection (dans le cas où l'on ajoute une projection dans un fichier 
existant)  

   (1) Faire un clic droit sur le fichier de formes concerné, « property » (propriétés), et aller dans l'onglet « XY 

coordinate_system » (système de coordonnées xy) et configurer la projection. 

 

 

 5-1-2-5 
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Exercice ① 

Démarrer « ArcCatalog ». 

 

Créer un nouveau fichier de formes (« Shapefile »). 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

1. Saisir un nom. 

2. Sélectionner le type d'objet (Feature Type) 

3. Choisir « Edit » (édition) 

 

 5-1-2-6 
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 5-1-2-7

4. Définir le système de coordonnées 

5. Choisir « Apply » (Appliquer) et « OK ». 

Nouveau fichier de formes créé dans la fenêtre ArcCatalog 

Glisser-déposer le fichier de formes de la fenêtre ArcCatalog dans la fenêtre ArcMap. 

               Choisir « Start Editing » (commencer l'édition) dans le menu « Editor » (Éditeur) 
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Chapitre 5-1-3  Acquisition de données dans ArcGIS  
3-1 Acquisition de données de « polygone », « polyligne », « point »  

(1) Ouvrir ArcMAP (Si nécessaire, ajouter un fichier de référence) 

 
(2) Ouvrir un fichier de formes pour l'intégrer (l'acquérir) dans ArcMAP (ex. new_pol) 

 

(3) Choisir « Start Editing » (commencer l'édition) dans le menu « Edit » (éditeur) 

   

 5-1-3-1 
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(4) Aller dans « Create features » (créer des entités) et sélectionner l'objet à créer. 

 
(5) Sélectionner le type de données à entrer et commencer l'acquisition.  

   
(6) Enregistrer les modifications (« Save Edits ») dans le menu « Editor » (éditeur) 

 
(7) Puis terminer l'édition.  

 

 5-1-3-2 
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 5-1-3-3 

3-2 Acquisition de données en mode « capture » (snapping)  
S'il est nécessaire d'accrocher les données à acquérir aux données de référence, ouvrir la barre d'outils de capture  

(« Snapping toolbar ») dans le menu « Edit ». 

 
 

 
Capture 

 Capture de point 

 Capture d'extrémité  

 Capture de sommet 

 Capture de bord 

 

3-3 À noter en matière d'acquisition des données en mode de capture (« SNAP mode ») 
(1) Acquisition de polygone 

Tous les points (extrémités sommets) doivent être accrochés au polygone voisin. 

Dans le cas d'un polygone torique (en forme d'anneau), acquérir d'abord le polygone intérieur, puis 

l'extérieur, et rogner le polygone intérieur. 

(2) Acquisition de polyligne 

Dans le cas ou acquisition se fait en dupliquant, tous les points doivent être capturés, et s'il n'y a pas de 

point à capturer, on créera une extrémité. 

(3) Acquisition de point  

Dans le cas d'un accrochage sur une ligne ou un polygone, le point doit être accroché à un point sur la ligne 

ou sur le polygone. 
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Chapitre 5-1-4  Gestion des attributs dans ArcGIS 
 

4-1 Ajout d'un champ 
(1) Faire un clic droit sur la forme concernée, choisir « Open attribute table » (Ouvrir la table d'attributs), et 

ouvrir la table d'attributs.  

   
(2) Choisir « Add field » (ajouter un champ) dans les options de la table. 

 
(3) Saisir le nom de champ (« Field name »), définir le Type (« Integer » (= nombre entier), « double », « text », 

etc.) et la précision.   

 5-1-4-1 
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4-2 Supprimer un champ  
(1) Faire un clic droit sur la forme concernée, choisir « Open attribute table » (Ouvrir la table d'attributs), et 

ouvrir la table d'attributs. 

  
(2) Faire un clic droit sur le champ concerné et choisir « Delete Field » (supprimer le champ).  
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4-3 Entrer un attribut  
(1) Faire un clic droit sur le nom du champ et choisir « Field » (champ) dans la table d'attributs. 

 
 

(2) Saisir la formule ou la valeur dans la fenêtre du bas, puis cliquer sur OK.  
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4-4 Chercher des données par attribut 
 

   (1) Cliquer sur le bouton « Select By Attributes » (Sélectionner par attribut) dans la table d'attributs. 

 

   (2) Saisir la formule ou la valeur dans la fenêtre du bas puis « Apply » (Appliquer). 

   

(3) Le nombre de dossiers trouvés est affiché en bas de la fenêtre.  
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Chapitre 5-1-5  Analyse spatiale / analyse de base 
 

5-1 Analyse spatiale 
   (1) Cliquer sur « Select By Location » (sélectionner par emplacement) dans le menu « Selection ». 

 

   (2) Définir les conditions de recherche. 

Définir la méthode de sélection (« Selection method »), la (les) couche(s) cible (« Target layer(s) »), la couche 

source (« Source layer »), la méthode de sélection spatiale (« Spatial selection method »), etc., puis appliquer 

(« Apply ») 

 
   (3) Le nombre de dossiers trouvés est affiché tout en bas de la fenêtre. 

 

 

 5-1-5-1 



Étude sur l'établissement d’une base de données topographique au Togo 
Manuel de transfert de technologie  

 5-1-5-2 

 

5-2 Analyse de base 
 

 
(1) Zone tampon (« Buffer ») 

Créer des données polygone à l'extérieur de la couche concernée avec la zone tampon en entrée.  

(2) Découpage (« Clip ») 

    Créer des données polygone à l'intérieur de la couche de découpage à partir de la couche concernée.  

(3) Croisement (« Intersect ») 

       Créer des données polygone à l'intérieur de la couche de croisement à partir des couches concernées. 

(4) Union  

    Créer une couche à partir des couches sélectionnées (en cas d’informations redondantes, un seul attribut). 
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Chapitre 5-2-1  Techniques de base d'ArcGIS (Première partie) 
 

1-1 Ouvrir ArcMAP. 
(1) Ouvrir un nouveau fichier « ArcMAP 10 ». 

Cliquer sur l'icône du raccourci d'ArcMAP 10 sur le bureau (« Desktop »). 

(2) La fenêtre suivante apparaît : 

  
 

1-2 Ajouter les données XY  
(1) Vérifier le système de coordonnées des données XY (données Excel).  

(2) Appliquer le système de coordonnées. 

Dans le menu « View » (affichage) choisir « Data Frame Properties » (propriétés du cadre de données), 

pour ouvrir la fenêtre des propriétés du cadre de données. Sélectionner ensuite l'onglet « Coordinate 

System » (système de coordonnées). 

1. Sélectionner le système de coordonnées. 

Dans le cas présent, le système de coordonnées 

est « WGS 1984 »).  

2. Sélectionner « OK ». 
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(3) Ajouter des données XY 

Dans le menu « File » (fichier), choisir « Add Data » (ajouter des données), « Add XY Data » (ajouter des 

données XY) pour ouvrir la fenêtre qui suit : 

1. Sélectionner le fichier de données XY. 

(Dans le cas présent, sélectionner le fichier Excel). 

 

Les points seront affichés ainsi : 

 
 

 

 

 

2. Sélectionner le champ X (« X Field ») et le champ Y 

(« Y Field »). 

3.  (Option) Sélectionner le champ Z (« Z Field »).  

4. Sélectionner OK. 
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(4) Enregistrer le fichier au format Shape 

Sélectionner la couche de données de points, faire un clic droit, et choisir « Data » (données), « Export Data » 

(exporter les données). 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

La fenêtre suivante s'ouvrira alors : 

 
1. Sélectionner « the data frame » ((Utiliser le même 

système de coordonnées que) le cadre de 

données) 

 

 

 

 

 

 

 

 

2. Définir la classe d'objets de sortie (Output feature 

class).

3. Sélectionner « OK ». 

 

 

Les données de fichier « Shape » seront exportées. 

 

 

 5-2-1-3



Étude sur l'établissement d’une base de données topographique au Togo 
Manuel de transfert de technologie  

1-3 Transformation des coordonnées  
(1) Ouvrir un nouveau projet ArcGIS. Dans le menu « View » (affichage), choisir « Data Frame Properties » 

(propriétés du cadre de données).  Appliquer le système de coordonnées. 

(Dans le cas présent, choisir « WGS_1984_UTM_ZOON31N »). 

 

 

 

 

 

 

 

 

 

 

 

(2) Ajouter des données pour la transformation des coordonnées. (Dans le cas présent, ajouter les données exportées 

auparavant dans le cadre de ce manuel au paragraphe 1-2(4)). 

(3) Sélectionner les données de point, faire un clic droit, « Data » (données), « Export Data » (exporter les données), 

et la fenêtre d'exportation des données « Export Data » s'ouvrira.  

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

1. Sélectionner « All Features » (tous les objets). 

Les données transformées seront exportées.  

 

3. Entrer la classe d'objets de sortie.  

2. Sélectionner « the data frame » ((Utiliser le même 
système de coordonnées que) le cadre de données) 

4. Sélectionner « OK ». 
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1-4 Fusionner  
(1) Ouvrir un nouveau projet ArcGIS. Ajouter les données à fusionner. 

(2) Ouvrir la boîte à outils Arc (« Arc Toolbox ») et sélectionner « Data Management Tools » (outil de gestion 

des données), « Generalization » (généralisation), « Dissolve » (fusionner). 

   

 

1. Sélectionner « Input Features » (les objets en 
entrée). 

2. Définir la classe d'objets de sortie (Output feature 
class). 

3. Sélectionner « Dissolve Field(s) » (fusionner le(s) 
champs). 

4. Sélectionner « OK ». 

 

Les données fusionnées seront affichées dans la fenêtre de carte. 
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1-5 Totalisation 
(1) Ajouter des données à superposer (Données de polygone et de point). 

(2) Sélectionner les données de point, faire un clic droit, « Joins and relates » (joint et met en relation), « Join » 

(joindre).  

1. Sélectionner la couche à joindre à cette couche. 

2. Sélectionner « it falls inside » ((Tous les attributs du 
polygone seront conférés à chacun des points) qui 
tombe à l'intérieur du polygone). 

3. Définir la classe d'objets de sortie (Output feature 
class). 

4. Sélectionner « OK ». 

 

(3) Ouvrir « Arc Toolbox » (boîte à outils Arc), et sélectionner « Analysis Tools » (outil d'analyse), « Statistics », 

« Frequency » (fréquence).  

1. Sélectionner la table en entrée (Input Table). 

2. Définir la table en sortie (Output Table). 

3. Choisir « Frequency Field » (champ de fréquence). 

4. Sélectionner « OK ». 

 

La nouvelle table s'affichera.  
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1-6 Visualisation  
(1) Sélectionner « View » (Affichage), « Graphs » (graphiques), « Create » (créer), pour afficher l'assistant de 

création de graphique (« Create Graph Wizard »). 

(2) Suivre les instructions de l'assistant pour créer des graphiques à votre guise. 
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Chapitre 5-2-2  Techniques de base d'ArcGIS (Deuxième partie) 
 

2-1 Mise à jour de la table d'attributs (première partie) 
(1) Ouvrir « ArcGIS » et ajouter des données. 

(2) Ouvrir la table d'attributs. 

(3) Ajouter un champ. Saisir un nom (« Name »), définir le « Type » et les propriétés du champ (« Field Properties »). 

(4) Sélectionner la barre d'outils « Editor », « Start Editing » (commencer l'édition). 

(5) Vous pouvez mettre à jour la table d'attributs, et saisir de nouvelles données.  

 
(6) Quand la mise à jour est terminée, sélectionner la barre d'outils « Editor », « Stop Editing » (arrêter la mise à jour), et 

« Save Data » (enregistrer les données). 

 

2-2 Mise à jour de la table d'attributs (deuxième partie)  
(1) Ouvrir la table d'attributs. 

(2) Ajouter un champ. Saisir un nom (« Name »), définir le « Type » et les propriétés du champ (« Field Properties »). 

(3) Sélectionner « New Field » (nouveau champ), faire un clic droit, sélectionner « Calculate Geometry » (calculer la 

géométrie). 

 

La fenêtre suivante s'affichera : 
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1. Vérifier la configuration. 

2. Sélectionner « OK ». 

 

 

2-3 Mise à jour de la table d'attributs (troisième partie)  
(1) Ouvrir la table d'attributs. 

(2) Ajouter un champ. Saisir un nom (« Name »), définir le « Type » et les propriétés du champ (« Field Properties »). 

(3) Sélectionner « New Field » (nouveau champ), faire un clic droit, sélectionner « Calculate Geometry » (calculer la 

géométrie). 

1. Saisir la formule de calcul. 

2. Sélectionner « OK ». 

 

 

2-4 Visualisation  
Vous pourrez visualiser les résultats en modifiant la configuration de symbologie ou en créant des graphiques.  
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Chapitre 5-2-3  Techniques de base d'ArcGIS (Troisième partie) 
 

3-1 Ouvrir ArcMAP. 
Ouvrir une nouvelle fenêtre ArcMAP. Définir le système de coordonnées.  

Dans le menu « View » (affichage) sélectionner « Data Frame Properties » (propriétés du bloc de données).  

Sélectionner l'onglet « Coordinate System » (système de coordonnées), paramétrer le système de coordonnées sur 

« WGS_1984_UTM_ZOME_31N ». 

 

3-2 Add Data (Ajout de données) 
Ajouter des données de préfecture et de routes nationales à partir d'un dossier de données. 

 

 

 

 

 

 

 

 

 

 

 

3-3 Croiser les données  
Dans le menu « Geoprocessing » (géotraitement), sélectionner « Intersect » (croiser).  

 

 

1. Définir les objets en entrée (Input Features).  

(National_Road.shp et Prefecture.shp)  

 

 2. Définir la classe d'objets en sortie. (Output 

Feature Class) 

 
3. Cliquer sur OK.  
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Une nouvelle couche de lignes sera créée dans la fenêtre ArcMAP.  

Ouvrir la table d'attributs de cette nouvelle couche de lignes.  

 

 

 

 

 

 

 

 

 

 

 

 

Les attributs des données de préfecture sont importés. 

Ensuite, dans les options de table (« Table Option »), sélectionner « Add Field » (ajouter un champ).  

Configurer comme dans la figure suivante. Cliquer ensuite sur « OK ».  

 

 

 

 

 

 

 

 

Name (nom) : Length (Longueur) 

Type : Double 

Precision : 10 

Scale (échelle) : 3 

Sélectionner ce nouveau champ « Length » et faire un clic droit, sélectionner « Calculate Geometry » (calculer la 

géométrie).   

Configurer comme dans la figure suivante. Cliquer ensuite sur « OK ».  

 

 

 

 

 

 

 

Property (propriété) : Length 

(Longueur) 

Units (unité) : Meters [m] 
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3-4 Résumés statistiques 
Dans la boîte à outils Arc (« Arc Toolbox »), sélectionner « Analysis Tools » (outils d'analyse), « Statistics » (statistiques), 

« Summary Statistics » (résumés statistiques).  

 

 

 

 

 

 

 

 

 

 

 

 

 

 

1. Définir la table en entrée (« Input Table) » 
(« Intersected Line Shape » = Forme de ligne 
croisée) 

2. Définir la table en sortie (« Output Table ») 

3. Sélectionner un champ de statistiques 
(Champ de longueur (Length)). 
Et sélectionner le type de statistiques 
(SUM = Somme) 

4. Sélectionner un champ de récapitulation 
(champ de préfecture (« Prefecture »)) 

5. Cliquer sur « OK ». 

 

Une nouvelle table est créée. Ouvrir une nouvelle table. 

Les champs « Frequency » (fréquence) et « Sum_Length » (somme_longueur) seront créés dans chaque préfecture 

comme ci-dessous :  

 

 

 

 

 

 

 

 

 

 

 

 

 

À partir de cette table, vous pourrez créer un graphique.   
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3-5 Joindre des attributs à partir d'une table 
Sélectionner la couche polygone des préfectures. Faire un clic droit. Sélectionner « Joins and Relates » (joint et met en 

relation) et « Join » (joindre).   

 

 

 

 

 

 

 

 

La fenêtre « Join Data » (joindre les données) s'ouvre. Configurer comme ci-dessous :  

 
1. Sélectionner l'option : 

 
« Join attributes from a table » (joindre les attributs 

à partir d'une table). 
 

 

 2. Choisir le champ : 
 PREFECTURE 
 

3. Choisir la table à joindre. 

 4. Choisir le champ : 
 PREFECTURE 

 
5. Sélectionner les options de jointure (Join 

Options) :  
Keep all records (garder tous les 
enregistrements) 

 

 

 

 
6. Cliquer sur « OK ».  

Certains champs seront joints dans la table de la couche précédente.  
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3-6 Visualisation  
Sélectionner la couche polygone des préfectures. Choisir « Properties » (propriétés),  onglet « Symbology » 

(symbologie). 

Changer les symboles comme vous voulez. 

 

 

 

 

 

 

 

 

 

 

 

 

Sélectionner la couche polygone des préfectures. Choisir « Properties » (propriétés)  onglet « Labels » (étiquettes). 

Changer la configuration des étiquettes comme vous voulez. 
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Chapitre 5-2-4  3D Analyst  
 

4-1 Créer des objets 3D 
(1) Ouvrir un nouveau projet ArcGIS, et ajouter des objets 2D (pour les convertir en objets 3D). 

(2) Ouvrir « Arc Toolbox » (boîte à outils Arc), et sélectionner « 3D Analyst Tools » (outils 3D Analyst), « 3D 

Features » (objets 3D), « Feature To 3D By Attribute » (objets en 3D par attribut). 

 

 

 

 

 

 

 

 

 

 

 

 

 

(3) Ouvrir un nouveau projet ArcScene, et ajouter des objets 3D. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

1. Choisir « Input Features » (objets en entrée) 

2. Définir la classe d'objets de sortie (Output feat

class

ure 

).

3. Sélectionner le champ de hauteur (« Height Field »)

4. Sélectionner « OK ». 

 5-2-4-1



Étude sur l'établissement d’une base de données topographique au Togo 
Manuel de transfert de technologie  

 

(4) Sélectionner « View » (affichage), « Scene Properties » (propriétés de scène), pour afficher la fenêtre qui suit. 

1. Définir l'exagération verticale (« Vertical 
Exaggeration ») 

(D'ordinaire, il est préférable de définir autour de « 5 
») 

2. Sélectionner « OK ». 

 

Vous pouvez maintenant voir un modèle 3D dans la fenêtre Arc Scene. 

 

4-2 Créer des données TIN   
(1) Ouvrir un nouveau projet ArcGIS, et ajouter des objets 3D. 

(2) Ouvrir « Arc Toolbox » (boîte à outils Arc), sélectionner « 3D Analyst Tools » (Outils 3D Analyst), « TIN 

Management » (gestion du TIN), « Create TIN » (créer un TIN). 

 

 

 

 

 

 

1.

 

 
 Définir le TIN en sortie (« Output TIN ») 

 

 
2. Choisir la classe d'objet en entrée (Input Feature 

Class). 

3. 

 

 

 
Choisir le champ de hauteur (« Height Field ») 

4.

 

 
 Sélectionner « OK ».  
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(3) Ouvrir un nouveau projet ArcScene, et ajouter le TIN. 

 

 

 

 

 

 

 

 

 

 

4-3 Draper des données d'orthoimage  
(1) Ajouter des données d'orthoimages  

 

 

 

 

 

 

 

 

 

 

1. Ajouter des données. 

2. Ouvrir la fenêtre « Add Data » (ajout de données)

3. Choisir les données d'orthoimage. 

4. Sélectionner « Add » (ajouter). 

 

(2) Sélectionner la couche d'image, faire un clic droit, « Properties » (propriétés). 
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 5-2-4-4

 

 

 

 

 

 

 

 

 

 

 

 

 

L'image s'affichera en 3D.  

 

1. Sélectionner l'onglet « Base Heights » 

(hauteurs de base)  

2. Sélectionner les données de TIN 

3. Cliquer sur OK. 



Étude sur l'établissement d’une base de données topographique au Togo 
Manuel de transfert de technologie  

 

Chapitre 5-3-1  Structuration des données  
 

1-1 Étudier le « Document de définition de la base de données topographique »  
Étudier le document de définition de la base de données, qui définit le contenu des données structurées qui sont à 

créer.  

En particulier, faire la revue des types de données « shape », des codes de données, des définitions d'attributs, et des 

contenus des attributs.  

 

1-2 Structuration des données 
(1) Limites (d’une ligne à un objet polygone)  

En premier lieu, ouvrir ArcMAP et configurer le système de coordonnées.  

Dans le menu « View » (affichage), sélectionner « Data Frame Properties » (propriétés du bloc de données), 

et aller dans l'onglet « Coordinate System » (système de coordonnées). 

(Dans le cas présent, choisir « WGS_1984_UTM_Zone_31N » dans le dossier des systèmes de 

coordonnées projetés.)  

Ajouter à ArcMAP les données de lignes au format dwg contenant l’index de l’orle et les limites 

administratives. 

 

 

 

 

 

 

 

 

Sélectionner les données ajoutées, faire un clic droit, choisir « Open Attribute Table » (ouvrir la table 

d'attributs). 
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Dans les options de table, sélectionner « Select by Attributes » (sélectionner par attributs) 

 

 

 

 

 

Saisir la formule dans la zone du bas.  

 

(Dans le cas présent, saisir comme suit :) 

"Layer" = '1001' OR "Layer" = '9999' 

 

À ce moment l'index et les limites  

administratives sont sélectionnés 

dans ArcMAP. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Tout en sélectionnant les limites administratives, 

dans la boîte à outils Arc, choisir « Data Management Tools »  

(outils de gestion des données) 

--> « Features » (objets) --> « Feature To Polygon »  

(d'objet à polygone). 
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Choisir « Input Features » (objets en entrée) 

Définir la classe d'objet polygone en sortie. 

Cliquer ensuite sur « OK ». 

 

(Dans le cas présent, le nom d'objet en sortie est le suivant) 

Limit_poly_1.shp 

 

 

 

 

Ensuite, le nouveau fichier « shape » de polygone est créé comme suit : 

 

 

 

 

 

 

 

 

 

 

 

Dans la barre d'outils « Editor », sélectionner « Start Editing » (commencer l’édition). 

 

 

 

 

 

 

Choisir l'objet à mettre à jour. 
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Dans le cas présent, le petit polygone à gauche n'est pas  

nécessaire. (Car il est à l'extérieur du Togo). 

Il va donc être supprimé.  

(Sélectionner le polygone et presser la touche suppr (ou del)   
TOGO sur le clavier.) 

Frontière   

 

 

 

Sortir provisoirement du mode édition, puis enregistrer les données. Il faut sortir du mode édition car il ne 

permet pas d'ajouter les champs d'attribut.  

Après enregistrement, ouvrir la table d'attributs et ajouter les champs conformément aux définitions 

d'attributs. Saisir les attributs.  

 

Ajouter le champ « CODE » comme ci-dessous : 
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Ajouter le champ « NAME » (nom) comme ci-dessous : 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Ajouter le champ « AREA » (surface) comme ci-dessous : 
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La table d'attributs est créée, elle s'affiche comme ci-dessous:  

 

 

 

 

 

 

Ensuite saisir et éditer les valeurs d'attributs.  

Dans la barre d'outils « Editor », sélectionner de nouveau « Start Editing » (commencer l’édition). 

Saisir la valeur de « CODE » directement. (Dans le cas présent, la valeur est « 1001 ») 

Saisir aussi la valeur de « NAME » (nom). (Dans le cas présent, la valeur est « TOGO ») 

La valeur « AREA » (surface) est calculée automatiquement de la façon suivante :  

Choisir le champ « AREA », et faire un clic droit. Sélectionner « Calculate Geometry » (calculer la 

géométrie).  

 

 

 

 

 

 

 

Dans la fenêtre suivante, choisir « Area » dans le menu déroulant « Property » (propriété). Cliquer ensuite 

sur « OK ».  

 

 

 

 

 

 

 

 

 

Les attributs qui sont requis seront tous saisis. Enregistrer les données et arrêter l'édition.  

Ouvrir Arc Catalog, définir le système de coordonnées (« WGS_1984_UTM_Zone_31N ») des données 

mises à jour. 
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(2) Routes (De ligne à objet de ligne) 

Ajouter à ArcMAP des données de ligne DWG qui incluent des données de routes. 

 

 

 

 

 

 

 

 

 

 

Sélectionner les données ainsi ajoutées, faire un clic droit, choisir « Open Attribute Table » (ouvrir la table 

d'attributs). 

 

 

 

 

 

 

 

 

 

Dans les options de table, sélectionner « Select by Attributes » (sélectionner par attributs) 

 

 

 

 

Saisir la formule dans la zone du bas.  

 

(Dans le cas présent, saisir comme suit :) 

"Layer" LIKE '200%’ 

Cliquer sur « Apply » (appliquer). 

Les données de ligne de routes sont maintenant 

sélectionnées dans ArcMAP. 
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Sélectionner les données ainsi ajoutées,  

faire un clic droit, choisir « Data » (données) 

 « Export Data » (exporter les données). 

 

 

 

 

 

 

 

 

                                          

                                                 

 

 

 

 

 

 

Configurer comme ci-dessous et cliquer sur OK.  

Export : Selected features (les objets sélectionnées) 

Use the same coordinate system as (utiliser le même 

système de coordonnées que) :  

the data frame (le bloc de données)  

Output Feature Class (classe d'objet en sortie) :  

(data directory/) Route_Lin.shp 

Route_Lin.shp est ajouté dans la fenêtre ArcMAP. Ouvrir la table d'attributs. 
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Supprimer les champs superflus. (Dans le cas présent, supprimer “FID_”, “Entity”, “Color”, “Linetype”, 

“Elevation”, “LineWt”, et “RefName”.) 

Sélectionner le champ à supprimer, faire un clic droit, et choisir « Delete Field » (supprimer le champ)  

Ne pas supprimer le champ de couche (layer), parce que le contenu de ce champ est le même que celui du 

champ CODE.  

 

 

 

 

 

 

 

 

 

 

Ajouter le champ « CODE » comme ci-dessous : 
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Sélectionner le champ « CODE », faire un clic droit, et choisir « Field Calculator » (calculateur de champ).  

 

 

 

 

 

 

 

Saisir la formule dans la zone du bas.  

(Dans le cas présent, saisir comme suit :) 

[Layer] 

Cliquer ensuite sur « OK ».  

Dans le champ CODE, la valeur de couche est entrée. 

Supprimer le champ de couche (layer). 

Ensuite, ajouter les champs « NAME » (nom) et « LENGTH » (longueur) conformément aux définition 

d'attributs.  

 

 

 

 

 

 

 

Pour les routes nationales uniquement, saisir une valeur dans le champ « NAME ». En vous référant aux 

données de noms de routes nationales, vous serez en mesure de déterminer ce qu'il faut saisir. S'il n'y a pas 

de route nationale dans la carte, il n'est pas nécessaire de saisir une valeur dans le champ « NAME ». S'il y a 

une route nationale, lancer l'édition et saisir son nom directement dans la table. (comme par exemple « RN 

15 ») 

Ensuite, calculer la valeur du champ « LENGTH » (longueur) par la fonction de calcul de géométrie :  

Sélectionner le champ « LENGTH » (longueur), faire un clic droit et choisir « Calculate Geometry ».  

 

Property (propriété) : Length (Longueur) 

 Units (unité) : Meters [m] 

Cliquer ensuite sur « OK ».  
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(3) Petits bâtiments (de point à objet de point avec attribut d'angle) 

Ajouter à ArcMAP des données de point DWG incluant des données de petits bâtiments. 

 

 

 

 

 

 

 

 

 

 

Sélectionner les données ajoutées, faire un clic droit, choisir « Open Attribute Table » (ouvrir la table 

d'attributs). 

 

 

 

 

 

 

 

 

 

Dans les options de table, sélectionner « Select by Attributes » (sélectionner par attributs) 

 

 

 

 

Saisir la formule dans la zone du bas.  

 

(Dans le cas présent, saisir comme suit :) 

"Layer" = '3002' 

Cliquer sur « Apply » (appliquer). 

Les données de points de petits bâtiments sont 

sélectionnées dans ArcMAP. 
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Sélectionner les données ainsi ajoutées,  

faire un clic droit, choisir « Data » 

 (données)  « Export Data » 

 (exporter les données). 

 

 

 

 

 

 

 

 

                                          

                                          

 

 

 

Configurer comme ci-dessous et cliquer sur    « 

OK ».  

Export : Selected features (les objets sélectionnées)

Use the same coordinate system as (utiliser le 

même système de coordonnées que) : 

The data frame (le bloc de données) 

Output Feature Class (classe d'objet en sortie) : 

(data directory/) Batim_Pnt.shp                    
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Batim_Pnt.shp est ajouté dans la fenêtre ArcMAP. Ouvrir la table d'attributs. 

 

 

 

 

 

 

 

 

 

 

 

 

Supprimer les champs superflus. (Dans le cas présent, supprimer “FID_”, “Entity”, “Color”, “Linetype”, 

“Elevation”, “LineWt”, et “RefName”.) 

Sélectionner le champ à supprimer, faire un clic droit, et choisir « Delete Field » (supprimer le champ)  

Ne pas supprimer le champ de couche (layer), parce que le contenu de ce champ est le même que  

celui du champ CODE.   

 

 

 

 

 

 

 

 

Ajouter le champ « CODE » comme ci-dessous : 
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Sélectionner le champ « CODE », faire un clic droit, et choisir « Field Calculator » (calculateur de champ).   

 

 

 

 

 

 

 

 

Saisir la formule dans la zone du bas.  

(Dans le cas présent, saisir comme suit :) 

[Layer] 

Cliquer ensuite sur « OK ».  

Dans le champ CODE, la valeur de couche est entrée. 

Supprimer le champ de couche (« layer »). 

Ensuite, ajouter le champ « ANGLE » conformément à la définition d'attribut.  

 

 

 

 

 

 

 

 

Cependant dans ces données, le champ « angle » est déjà présent. On créera donc un champ temporaire 

« Temp ». Et on transférera la valeur de l'attribut d'angle à ce champ temporaire.   
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Ensuite, supprimer le champ « Angle », et ajouter un nouveau champ « ANGLE » conformément à la 

définition d'attribut. Enfin, transférer la valeur de l'attribut au nouveau champ « ANGLE » et supprimer le 

champ temporaire.  
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(4) Limites de réserve forestière, de parc national (de polygone à objet polygone) 

Ajouter à ArcMAP des données polygone DWG incluant des données de réserve forestière et de parc 

national.  

 

 

 

 

 

 

 

 

 

Sélectionner les données ajoutées, faire un clic droit, choisir « Open Attribute Table » (ouvrir la table 

d'attributs). 

 

 

 

 

 

 

 

 

 

 

Dans les options de table, sélectionner « Select by Attributes » (sélectionner par attributs) 

 

 

 

 

Saisir la formule dans la zone du bas.  

(Dans le cas présent, saisir comme suit :) 

"Layer" = '6111' 

Cliquer sur « Apply » (appliquer). 

Les données de polygone de parcs sont alors sélectionnées  

dans ArcMAP. 
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Sélectionner les données ainsi  

ajoutées, faire un clic droit, 

 choisir « Data » (données)  

 « Export Data » 

 (exporter les données). 

 

 

 

 

 

 

 

 

                                          

                                          

 

 

 

 

 

 

Configurer comme ci-dessous et cliquer sur OK.  

Export : Selected features (les objets sélectionnées)

Use the same coordinate system as (utiliser le 

même système de coordonnées que) : 

The data frame (le bloc de données) 

Output Feature Class (classe d'objet en sortie) : 

(data directory/) Parc_Poly.shp 
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Parc_Poly.shp est ajouté dans la fenêtre ArcMAP. Ouvrir la table d'attributs. 

 

 

 

 

 

 

 

 

 

 

 

 

Supprimer les champs superflus. (Dans le cas présent, supprimer “FID_”, “Entity”, “Color”, “Linetype”, 

“Elevation”, “LineWt”, et “RefName”.) 

 

Sélectionner le champ à supprimer, faire un clic droit, et choisir « Delete Field » (supprimer le champ)  

Ne pas supprimer le champ de couche (« layer »), parce que le contenu de ce champ est le même que celui 

du champ CODE.  
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Ajouter le champ « CODE » comme ci-dessous : 

 

 

 

 

 

 

 

 

 

 

 

Sélectionner le champ « CODE », faire un clic droit, et choisir « Field Calculator » (calculateur de champ).  

 

 

 

 

 

 

 

 

 

Saisir la formule dans la zone du bas.  

 

(Dans le cas présent, saisir comme suit :) 

[Layer] 

Cliquer ensuite sur « OK ».  

Dans le champ CODE, la valeur de couche est entrée. 

Supprimer le champ de couche (« layer »). 
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Ensuite, ajouter les champs « NAME » (nom) et « AREA » (surface) conformément aux définitions 

d'attributs.  

 

 

 

 

 

 

 

 

Saisir les valeurs dans le champ « NAME » en se référant à des données de noms de réserves forestières et 

de parcs nationaux, notamment les vieilles cartes.  

Ajouter les données de vieilles cartes. Dans la barre d'outils « Editor », sélectionner « Start Editing » 

(commencer l’édition).  

 

 

 

 

 

 

 

 

 

 

 

 

 

Dans la fenêtre « Start Editing », sélectionner « Parc_Poly ». 

Cliquer ensuite sur « OK ». 

 

 

Dans la barre d'outils « Editor », choisir le bouton « Attributes » (Attributs)  
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Ensuite, sélectionner le polygone dans la fenêtre de carte. Puis saisir les valeurs de « NAME » dans la table 

d'attributs. 

 

 

 

 

 

 

 

 

 

 

 

 

1. Sélectionner le 

2. Saisir les 

 

Calculer la valeur du champ « AREA » (surface) par la fonction de calcul de géométrie :  

Sélectionner le champ « AREA », faire un clic droit et choisir « Calculate Geometry ».  

 

Property (propriété) : AREA (surface) 

Units (unité) : Square Meters [sq m]  

(mètres carrés) 

Cliquer ensuite sur « OK ».  
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(5) Annotation (d'annotation à objet de point) 

En premier lieu, ouvrir ArcMAP et configurer le système de coordonnées.  

Dans le menu « View » (affichage), sélectionner « Data Frame Properties » (propriétés du bloc de données), 

et aller dans l'onglet « Coordinate System » (système de coordonnées). 

(Dans le cas présent, choisir « WGS_1984_UTM_Zone_31N » dans le dossier des systèmes de 

coordonnées projetés.) 

Ajouter les données d'annotation DWG à ArcMAP. 

 

 

 

 

 

 

 

 

 

Ouvrir la boîte à outils Arc (« Arc Toolbox »), et sélectionner « Conversion Tools » (outils de conversion)  

« To Geodatabase » (vers géodatabase)  « Import CAD Annotation » (importer une annotation DAO). 

 

 

 

 

 

 

 

 

 

 

 

 

En premier lieu, sélectionner une  

annotation dans « Input features » 

(objets en entrée).  

Cliquer ensuite sur le bouton « Output features class » (classe d'objet en sortie), et aller dans le dossier 

approprié. 
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Dans ce dossier, sélectionner le bouton « New File Geodatabase » (nouvelle géodatabase fichier). 

                                                              

 

 

 

 

 

 

 

 

 

Créer une géodatabase fichier temporaire comme ci-dessous. Puis faire un double clic sur cette nouvelle 

géodatabase. 

 

 

 

 

 

 

 

 

 

Saisir un nom temporaire d'objet comme ci-dessous. Puis cliquer sur le bouton « Save » (enregistrer). 

 

 

 

 

 

. 

 

 

 

 

Dans la fenêtre « Import CAD Annotation » (importer une annotation DAO) définir l'échelle de 

référence (« Reference scale »). (Dans le cas présent, saisir « 50000 »).  
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Cliquer ensuite sur « OK ».  

L'annotation de géodatabase sera importée dans la fenêtre de carte. 

 

 

 

 

 

 

 

 

 

 
Dans la boîte à outils Arc (Arc Toolbox), sélectionner  
« Data Management Tools » (outils de gestion des données)  
« Features » (objets)  « Feature Vertices To Points »  
(de sommets d'objets à points).  
 

 

                                                

 

 

 

 

 

 

Configurer comme ci-dessous et cliquer sur OK.  
Input Features (objets en entrée) :  
geodatabase annotation data (données d'annotation 
de géodatabase) 
Output feature class (classe d'objet en sortie) ; 
(data directory/) Ano_Pnt.shp
Point Type (type de point) : START
départ) 

                      
 (point de 

Les données de point seront affichées dans la fenêtre de carte. Ouvrir la table d'attributs du fichier 

Ano_Pnt.shp.  
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Supprimer les champs superflus. (Dans le cas présent, supprimer les attributs autres que « Layer » (couche), 

« Text » et « Txt Angle » (angle de texte). 

Sélectionner le champ à supprimer, faire un clic droit, et choisir « Delete Field » (supprimer le champ)  

Ne pas supprimer les champs de couche, de texte, et d'angle de texte, parce que leurs contenus sont les 

mêmes que ceux des champs CODE, CONTENTS (contenu) et ANGLE.  

 

 

 

 

 

 

 

 

 

 

 

 

(Dans la boîte à outils Arc, sélectionner « Data Management Tools » (outils de gestion de données)  

« Fields » (champs) « Delete Fields » (supprimer les champs), vous pouvez supprimer plusieurs champs 

d'un coup.) 

 

Ajouter le champ « CODE » comme ci-dessous : 
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 5-3-1-26

Sélectionner le champ « CODE », faire un clic droit, et choisir « Field Calculator » (calculateur de champ).  

 

 

 

 

 

 

 

 

Saisir la formule dans la zone du bas.  

 

(Dans le cas présent, saisir comme suit :) 

[Layer] 

Cliquer ensuite sur « OK ».  

Dans le champ CODE, la valeur de couche est entrée. 

Supprimer le champ de couche (layer). 

 

 

Ensuite, ajouter les champs « CONTENTS » (contenu) et « ANGLE » conformément aux définitions 

d'attributs.  

    

 

 

 

 

 

 

 

Comme pour « CODE », à l'aide de la fonction de calcul de champ (« Field Calculator »), calculer les 

valeurs des champs « CONTENTS » et « ANGLE ».  

 

Ouvrir Arc Catalog, définir le système de coordonnées (« WGS_1984_UTM_Zone_31N ») des données 

mises à jour. 

 

Fin 
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